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1. Introduction 

The Sniffer is a tool to monitor the communication of any Inpixon brand RF nodes. The Sniffer can monitor any RF 

traffic depending on the transmission settings of the Chirp or UWB radio module. The number of observed nodes 

depends on total number of nodes within radio range, radio conditions and nodes settings. 

 

The Sniffer is available in three variants, Sniffer-c V2 for Chirp (Part number: SNSWABEES), Sniffer-c V3 for Chirp (Part 

number: KN03SNILE) and Sniffer-u-v1 for UWB (Part number: KN02SNIER). The Sniffer GUI described in this document 

is used for both. Either version of the Sniffer comprises the following three components according to the RF 

technology: 

 

1. A PC-Application with a Graphical User Interface (GUI) which will be referred to as Sniffer GUI in the remainder 

of this document.  

2. A firmware for the appropriate RF-technology and hardware version which will be referred to as Sniffer-c 

firmware (for both HW versions of Chirp) and Sniffer-u firmware (UWB) respectively in the remainder of this 

document.  

3. A breakout board with the appropriate swarm bee module mounted, which will be referred to as DK+ board 

or Dev Board in the remainder of this document. 

a. Chirp: swarm bee LE V2 DK+ (Part number: BN02SWBLP) 

b. Chirp: Inpixon Swarm Chirp V3 Dev Board (Part number: KN03SWBLE) 

c. UWB: Inpixon Swarm UWB V1 Dev Board  (Part number: BN01SWBEP)  
 
 

Note: A DK+ board with Sniffer firmware has monitoring capabilities only and thus is not able to initiate ranging 

requests and communication operations to other nodes, nor will it respond to ranging requests coming from other 

nodes. 

1.1. Purpose 

This document describes the GUI and the handling of the Sniffer prerequisites. 
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2. Hardware Platform 

To enable the Sniffer to monitor the radio communication between nodes, a standard Dev Board with a dedicated 

Sniffer firmware (FW) is required. This FW is provided by Inpixon. The connection to a PC is done via an USB cable. 

(Type A – Type Mini USB for LE V2 DK+ and ER DK+ and Type A – Type Micro USB for Inpixon Swarm Chirp V3 Dev 

Board). 

 

 

 

 

Figure 2-2 Inpixon Swarm Chip V3 Dev Board 

 

Figure 2-1 LE V2 DK+ Board 
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Figure 2-3 Connection PC – DK+ 

 

Depending on the RF-technology you want to investigate (UWB or Chirp), we recommend using the appropriate 

Inpixon hardware to monitor the chosen signal type (see Section 1). 

2.1. Firmware 

A dedicated Sniffer firmware is required to enable the designated DK+ board to monitor the swarm. Please refer to 

section 3.2 for proper installation if required. For swarm bee LE V2, Sniffer-c V2 firmware with version 1.0.5 or higher 

is required. For swarm bee LE V3, Sniffer-c V3 firmware with version 1.0.5 or higher is required. For swarm bee ER, 

Sniffer-u-v1 firmware with version 1.0.1 or higher is required. 

2.2. Software 

Installation of the application requires Microsoft® Windows® 10 or later with a 2.0 GHz dual-core processor or 

equivalent and 2 GB memory. Also, a PC with an USB port is required. 

 

3. Installation 

Note: To obtain optimal results, the firmware provided with the installation file shall always be used. Always refer to 

section 2.1 for minimum firmware version required. 

3.1. Windows Software (GUI) 

Download the installation file from our e-library. https://www.nanotron.com/elibrary/ or an alternative URL provided 

by Inpixon. 

Open the downloaded installation file and follow the instructions. 

3.2. FW  

How to flash the DK+ board with the Sniffer firmware or vice versa is explained in document [2]. Please assure that 

you are using the correct image file before flashing. Otherwise, you may obtain unpredictable results or behavior. 
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4. Sniffer GUI and Handling 

4.1. Overview 

After the Sniffer has started, the window as shown in Figure 4-1 appears. Apart from the menu bar, two toolbars are 

displayed. The “Main Toolbar” serves to open, save, close a capture file session in offline mode or to start, stop an 

online live capture session. The “Filter Toolbar” is used to filter the captured raw data to minimize the information to 

the desired amount. The status bar displays if the application is connected to a DK+ board. The window has two 

frames. The “Short View” displays one event per line in a condensed manner while the “Detailed View” displays all the 

data belonging to the one selected line of the “Short View”. 

 
Figure 4-1 Opening window 

4.2. Offline Mode 

The offline mode allows to analyze the captured data from a file which has been saved before or when the live capture 

has been stopped. The data may be filtered, and the capture can be saved filtered or as raw data to a file. 

 

4.3. Online Mode 

The online mode is used to monitor and analyze real-time live data. The live monitoring is started and stopped using 

the Start/Stop in Capture settings in the Menu Bar. 
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4.4. Menu Bar 

4.4.1. File 

In the offline mode it is possible to playback a capture from a file which has been saved before or to save the filtered 

(refer to Section 5 for details about filtering) or unfiltered content of the current capture. 

 

 

Figure 4-2 Inpixon Sniffer GUI Menu Bar - File 

 

 

Table 4-1: Inpixon Sniffer GUI Menu Bar - File 

Function Description 

 Open… Opens a file 

Save Saves file unfiltered 

 Save As… Saves file unfiltered under another name or folder 

     Save Filtered Like Save as…, but with the current filter setting 

 Close Closes the current session 

 Properties… Displays the file properties 

      Exit Exits the application 

 

4.4.2. Capture 

The live monitoring can be started and stopped with the capture settings. 

 

 

 

Figure 4-3 Inpixon Sniffer GUI Menu Bar – Capture 
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Table 4-2: Inpixon Sniffer GUI Menu Bar - Capture 

Function Description 

 Start… Starts online capture 

 Stop Stops online capture 

 

4.4.3. Help 

Shows the version of the Inpixon Sniffer GUI software. 

 

 

Figure 4-4 Inpixon Sniffer GUI Menu Bar – Help 

 

4.5. Tool Bar  

The Tool Bar allows quick access to particular settings. 

 

 

Figure 4-4 Inpixon Sniffer GUI Tool Bar 

 

Table 4-2: Inpixon Sniffer GUI Tool Bar 

Function Description 

 Open Opens a file 

 Save Saves the file 

 Close Closes the current session 

 Start Starts the capture session 

 Stop Stops the capture session 

4.6. Capture Settings 

Before starting a capture session, some elementary parameters shall be set. 

 

For Sniffer-c firmware, the parameters are listed in Table 4-3. (Figure 4-5 shows the corresponding Capture 

Parameters window). Please refer to the corresponding device datasheet for supported modes on the device you 

want to capture data from. 
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Table 4-3: Inpixon Sniffer GUI Capture parameters for swarm bee LE 

Parameter Description 

Serial interface COM Port on which the DK+ board is connected to 

Transmission mode Transmission mode to listen to 80/1, 80/4 or 22/4 

Channel number Channel number to listen to. This is only needed for 

transmission mode 22/4 

Synchronization word Syncword to trace 

Capture filter Optionally filter settings as explained in section 5 

FEC If FEC is applied or not 

 

 

 

Note: Depending on the FW of the monitored nodes the range of the Syncword may change. 

FW: 2.1 range [0-8] 

FW: 3.0 range [0-12] 

 

 

 

For Sniffer-u firmware, the parameters are listed in Table 4-4. (Figure 4-6 shows the corresponding Capture 

Parameters window). 

 

 

 

 

 

 

 

 

Figure 4-5 Capture parameters Sniffer-c 

firmware 
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Table 4-4: Inpixon Sniffer GUI Capture parameters for swarm bee ER 

Parameter Description 

SDMD Select transmission mode according to swarm bee ER 

specification 

All others Details according the selected transmission mode are 

shown below the SDMD field. These cannot be 

changed. They are provided for informational 

purpose only 

 

 

 

Figure 4-6 Capture parameters Sniffer-u firmware 

 

 

If no device is attached or the device attached does not have any Sniffer firmware, the device type will be indicated 

as N/A (not available). The capture Parameters window then looks like shown in Figure 4-7. 
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4.7. Capture View 

4.7.1. Short View 

The “Short View” displays one event per line in a condensed manner. Each column provides the following information 

listed in Table 4-5. 

 

Table 4-5: Inpixon Sniffer GUI Short View Description 

Parameter Description 

No. Current sequence number 

Time 
Timestamp of the event generated by the DK+ board 

hh:mm:ss.ms 

Source Source node address 

Destination Destination node address 

Info Brief information of the event 

 

Note: The destination address FF:FF:FF:FF:FF:FF is used by broadcast messages 

 

The colors have following meanings listed in Table 4-6. 

 

 

 

 

 

 

Figure 4-7 Capture parameters window with 

unknown device type 
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Table 4-6: Inpixon Sniffer GUI Messages Color Code 

Color  Description 

Plum (█████) Swarm ranging result 

Deep-Pink (█████) Swarm ranging error 

Lawn-Green (█████) ISO blink 

Navjo-White (█████) Ranging step 0 of Swarm Chirp and UWB 

Orange (█████) All other ranging steps of Swarm Chirp and UWB 

Light-Blue (█████) Swarm Chirp Broadcast (pacer and TDOA blinks) 

Swarm UWB data packet (pacer and TDOA blinks) 

Light-Steel-

Blue 

(█████) AIR protocol of Swarm Chirp and UWB 

Deep-Sky-

Blue 

(█████) Asset Tag TDOA Blink 

Light-Sky-Blue (█████) Asset Tag AIR protocol 

Seashell (█████) Swarm Chirp and UWB flashme packet 

Blanched-

Almond 

(█████) FOTA Chirp and UWB packet 

Bisque (█████) FOTA Chirp and UWB status packet 

 

 

 

 

Figure 4-8 Short View Sniffer-c Firmware 

 

The output of Sniffer-u firmware looks very similar to the Sniffer-c firmware. The address format has 8 bytes instead 

of 6 bytes.  

 

 

Figure 4-9 Short View Sniffer-u Firmware 

 

4.7.2. Detailed View 

The “Detailed View” gives detailed information of the selected event line in the “Short View”. An example of a ranging 

result for swarm bee Chirp (Figure 4-10) and swarm bee UWB (Figure 4-11) is shown below. 
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Figure 4-10 Detailed View for Dev Board with Sniffer-c Firmware 
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Figure 4-11 Detailed View for Dev Board with Sniffer-u Firmware 
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5. Filter 

Two menus are offered for filtering. ”Apply Filter” and “Prepare Filter”. The “Apply Filter” is used to filter a single 

condition and to apply the setting. Alternatively, it can be used when a suite of conditions has been set by the “Prepare 

Filter” to add the last condition and apply the whole setting. The “Prepare Filter” is used to concatenate several logical 

conditions. Moreover, the filter line can be edited to refine or to create more complex settings. 

5.1. Apply Filter 

To filter a particular item, position the mouse cursor to the row and line of this item in the “Short View” and click the 

right mouse button. Then: 

 

Apply Filter -> Selected 

 
Figure 5-1 Apply Filter 

 

In the case it is the last condition of concatenated conditions, select the appropriate logical operation after “Apply 

Filter”.  This will close and apply the setting immediately. 

 

E.g.: Cond_1 or Cond_2 

 
Figure 5-2 Apply Filter with "or" condition 

 

Note: It is also possible to select an item in the “Detailed View” as filter condition 
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5.2. Prepare Filter 

“Prepare Filter” is used to concatenate several logical conditions. The principle is the same as for the “Apply Filter” 

except it won’t apply the settings immediately. The filter line is left open and a new condition can be added. To apply 

the settings, press the “Apply” button next to the filter line or alternatively use “Apply Filter” as last step as explained 

in the previous section. 

 

 

 
Figure 5-3 Add Filter with "and" condition 

 

 

5.3. Example 

This example shows how to filter the ranging steps 0 to 2. 

 

 
Figure 5-4 Original Screen 

 

1. Move mouse pointer to row 2, info field Prepare Filter -> Selected 

2. Move mouse pointer to row 3, info field Prepare Filter -> … or Selected 

3. Move mouse pointer to row 4, info field Apply Filter -> … or Selected 

 

 
Figure 5-5 Filtered Screen 
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5.4. Edit Filter 

To refine or to create complex filter settings, it is possible to edit the setting in the filter line of the “Filter Toolbar”. 

 

 
Figure 5-6 Filter Line 

 

One way is to type the filter expression by hand or to use the “Prepare-, Apply Filter” tool to gather the correct 

parameters and to apply manually the necessary changes like brackets to group conditions or logical operators. 

 

 

5.4.1. Reset Filter 

To reset the current filter, press the “Clear” button. This will clear the expression in the filter line. It is then necessary 

to press the “Apply” button. 

5.4.2. Example 

This example will change the filter from Ranging Step 0 to 2. 

 

Looking at Figure 5-4 select pointer 1 and apply. The result is displayed below 

 

 
Figure 5-7 First Step 

 

Replace 0 by 2 and press “Apply” 

Note: If an expression cannot be parsed, the background color becomes pink and it is not possible to “Apply” 

 

 
Figure 5-8 Second Step 

 

More details about the syntax and the field properties can be found in document [1] 

 

 
Figure 5-9 Incorrect Expression 
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6. Capture Properties 

The properties of the current capture (live or file) can be displayed. These are mainly the settings as explained in 

section 4.6. This can be meaningful when the capture settings are unknown or forgotten. 

 

From the Menu Bar: File -> Properties 

 

 
Figure 6-1 Open Properties 

 

An example for the properties window for Chirp is shown in Figure 6-2. An example for UWB in Figure 6-3.The 

difference are the transmission mode parameter which are apparently different for swarm bee Chirp and swarm bee 

UWB. 

 

 
Figure 6-2 Properties Chirp 
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Figure 6-3 Properties UWB 
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7. References 

 

[1] Sniffer Filter Expression NA-16-0356-0044 

[2] AN0507 swarm bee LE Firmware Update NA-14-0267-0017-1.0 
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Life Support Policy 

 

These products are not designed for use in life support appliances, devices, or systems where malfunction of these 

products can reasonably be expected to result in personal injury. Inpixon (including its affiliates and subsidiaries) 

customers using or selling these products for use in such applications do so at their own risk and agree to fully 

indemnify for any damages resulting from such improper use or sale. 
 

 

 

 

About Inpixon 

 

Inpixon® (Nasdaq: INPX) is the innovator of Indoor Intelligence™, delivering actionable insights for people, places and 

things. Combining the power of mapping, positioning and analytics, Inpixon helps to create smarter, safer, and more 

secure environments. Inpixon customers can take advantage of industry leading location awareness, RTLS, workplace 

and hybrid event solutions, analytics, sensor fusion and the IoT to create exceptional experiences and to do good 

with indoor data. 
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